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1 Introduction
The IPECS SoftPhone is a PC based application which links the operation of an on-screen multi-button telephone with other communications related PC applications.   IPECS SoftPhone is visualized on the desk-top and interfaced to the user via the mouse and keyboard.  All the features of the traditional IPECS multi-button phone are available to the user.  A Phone Book database with links to the user’s PIM (Personal Information Manager) provides pop-ups for incoming caller identification.  IPECS SoftPhone users can employ the Phone Book to place calls as well as manage contact records.  Other special functions available to IPECS SoftPhone users include: appointment scheduling, SMS support, e-mail and call recording.

Features of the IPECS SoftPhone include: 

· Automatic database synchronization

· Display Mode (Phone/Keyset/Small, Calendar/Keypad)

· Phone Book calling

· Phone Book Management
· Database import/export (MS Outlook, GoldMine, ACT!, Excel)
· Scheduled Dial

· User call log

· User SMS (Short Message Service)

· Voice Recording

· Connection Mode (Local/ Remote)

· Multi-language support
· E-mail with MS Outlook

· Flex button labels
· Incoming call pop-up window

· Help
2 Installation and setup

Set-up of the IPECS SoftPhone is a three step process; 

1. connect the PC to the host IPECS system,

2.  install the IPECS SoftPhone application on the users’ PC, and

3.  complete registration of the SoftPhone application to the IPECS system.

Completing the registration process may require assistance of the IPECS system administrator to adjust settings of the IPECS.  For remote applications, the IPECS will require entry of the MAC address of the PC running the IPECS SoftPhone.  Also, for remote users, the IPECS SoftPhone will require entry of the host IPECS system IP address.  

Prior to installation, the PC and operating system should be verified for compatibility with the IPECS SoftPhone application.  Assure that the PC and OS (Operating System) comply with the minimum requirements of sections 2.1 and 2.2.

2.1 System requirements

The minimum requirements for the IPECS SoftPhone PC are described below.

· Pentium 3 or compatible CPU
· 500 MHz clock speed or higher

· 128 Mbytes RAM 

· 200 Mbytes of free hard-drive space
· 1024 x 768 resolution monitor
· CD-ROM drive
2.2 Supported operating systems

The IPECS SoftPhone application can run under any one of several Microsoft Operating Systems including:

· Microsoft Windows XP

· Microsoft Windows 2000

· Microsoft Windows 98

· Microsoft Windows 98 Second Edition

2.3 IPECS Connection
The PC running the SoftPhone application may be connected to the IPECS system either as a local or remote device.  The connection as a local device requires the SoftPhone connect to the same LAN as the host IPECS system.  When connecting as a remote device, the PC’s MAC address must be assigned as a Remote device in the IPECS for proper registration and operation.  Refer to section 2.5.3 for additional information on remote operation.  Figure 2.3 provides a pictorial view of the connections to the IPECS.
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Figure 2.3 IPECS SoftPhone Connections

2.4 SoftPhone Application Installation

When the IPECS SoftPhone CD-ROM is placed in the PC, an auto-execute install program will start.  The install Wizard as shown in Figure 2.4a will appear.  Click the Next > button to continue with the install process.  To abandon the installation, click Cancel. 
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Figure 2.4a IPECS SoftPhone Install Wizard

In the next installation step, the default destination folder for the SoftPhone application can be modified using the Change button.  The default directory for installation is “C:\Program Files\IPECS SoftPhone\”, Figure 2.4b.  It is possible to back-up one step in the install process or to cancel the installation.    To continue the installation click the Next> button.
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Figure 2.4b Install folder

Once the IPECS SoftPhone application has been installed, it is necessary to install WinPcap2_3.exe.  You will be asked and must agree to the WinPcap license terms, Figure 2.4c, to complete the SoftPhone installation. 
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Figure 2.4c WinPcap License Window

2.5 Registration

2.5.1 IPECS Lock-key 

Prior to registration of the IPECS SoftPhone with the host IPECS system, the host IPECS system will require installation of the SoftPhone software lock-key.  This is accomplished by the IPECS system administrator under the system’s Maintenance window.  The administrator should reference the IPECS Admin and Maintenance Manual for guidance.

2.5.2 Registration Process

When IPECS SoftPhone is run the first time, it attempts to register with the system.  The initial registration, when locally connected, is automatic assuming the IPECS system is set to allow registration, refer to the IPECS Installation manual for the MFIM Registration Switch settings.  

When the IPECS SoftPhone is remotely connected the first time, registration will fail unless pre-registered in a local environment.  When this occurs, the host IPECS system IP address must be entered and the connection mode change to remote in the Registration Error dialog box, Figure 2.5.3.  Also assure the correct MAC is In Use, is displayed in the message window.  Such failure may also occur due to use of an improper IP address or MAC address, which can be corrected as outlined in section 2.5.3
For a locally connected device, audio is from point to point over the LAN, NAT (Network Address Translation) is not supported and IPSEC is not implemented. For a remotely connected device, audio is handled through an IPECS system VoIP channel and remote NAT  is supported.

To run the SoftPhone application;

· select the IPECS SoftPhone shortcut icon, the IPECS SoftPhone application will start and attempt to register with the host IPECS system.

2.5.3 Remote Registration Error

If a registration error occurs, the user will receive a Registration Error message and dialog box, Figure 2.5.3.  In the dialog box, the user may enter the IP Address for the host IPECS, and configure the SoftPhone Connection mode (section 5.3.2) and appropriate MAC for the PC.   To enter information in the dialog box;
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Figure 2.5.3 Registration Error message & dialog box

System IP Address:

· select New IP Address box,

· enter new IP Address.

Connection Mode:

· select Local or Remote radio button.

PC Network Interface Card:

· if the PC has multiple NICs, e.g. wired, wireless, VPN network support, etc., select the desired NIC from the drop down menu under In Use MAC.

After changing characteristics in the message box it may be necessary,

· select Retry to register,

· close the IPECS SoftPhone application,

· restart the application. 

Registration error messages that may be received include:

No Response from System – 
there is no connection over the LAN to the host IPECS, the host IP address is incorrect, the IPECS is not set for local registration, the wrong NIC (MAC) is being used.

Current Adapter NOT presently Available – the currently defined NIC is in use by another application, not connected, or has failed to properly connect to the LAN.

3 IPECS SoftPhone Operation

3.1 Overview

IPECS SoftPhone interfaces with the user through the IPECS SoftPhone window, Figure 3.1a.  At the top of the SoftPhone window is the Menu bar and below the Menu bar is the SoftPhone Tool bar.  

There are two SoftPhone views, Phone and Keyset.  The Phone view, Figure 3.1a, emulates the basic IPECS phone; an LCD area, keypad and fixed feature buttons are arranged generally as with the traditional IPECS phone.  The fixed feature buttons give the user access to features and resources of the IPECS with the same displays as the LCD of an IPECS multi-button phone.  The user may dial with the mouse from the Keypad window or with numeric keys on the PC keyboard.  Below the keypad, are the volume control up/down buttons and window selection buttons (Calendar and Keypad).  The separate Speaker and Microphone icons are used to adjust the volume of the microphone or speaker independently with the adjustment slide bar to the right of the icons.
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Figure 3.1a Phone view w/Keypad Window

Figure 3.1b Phone view w/Calendar Window

The Keypad window can be toggled to a Calendar window, Figure 3.1b, which links to the user’s Outlook appointment scheduler.  The Calendar view includes a scrolling display of daily events below the Calendar and allows access to the scheduler for managing appointments.  At the bottom of the window, the user may access the SMS (Short Message Service) features of the IPECS SoftPhone to exchange short text messages with other users.

The Keyset view, Figure 3.1c, adds the 4 Keyset folders to the right of the Phone view.  The folders include Flex Button, Phone Book, Call Log and Scheduled Dial folders.  The Flex Button folder emulates the multi-button function of the traditional 24 button IPECS phone.  The 24 Flex Buttons are used in the same manner as the traditional IPECS phone and are fully programmable in the IPECS system database.
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Figure 3.1c IPECS SoftPhone Keyset view

The user’s contact manager can be imported for the Phone Book folder, displaying information on contacts registered in the contact manger database.   The Phone Book is employed to place calls and send e-mails and can be searched, sorted and edited.  The Phone Book database can be synchronized with an external source database each time the IPECS SoftPhone application is run.  Also, changes made to the Phone Book database can be automatically exported to the external database to maintain synchronization.

The Call Log folder maintains a database with a record of each call placed or received by the IPECS SoftPhone.  The Call Log, fi enabled, can be viewed, sorted and printed or can be disabled so no log records are generated.

In the Scheduled Dial folder the user can input a phone number and a date & time to call the number; at the scheduled time the system will confirm and place the requested call.

3.2 Placing & Receiving Calls
3.2.1 Placing a Call

The basic operation of placing a call for the IPECS SoftPhone is the same as the traditional IPECS multi-button phone.  Dialing is accomplished by selecting digits from the Keypad window with the mouse or using numeric keys on the PC keyboard.

For internal calls to other IPECS system users;

· Dial the station number or press a DSS/BLF Flex button.  The digits will display in the LCD area.

· Press the “Space” bar or select the Speaker button with the mouse to terminate the call.

For calls external to the IPECS system;

· Select a Line button or dial the CO access code (generally ‘9’),

· Dial the desired number.

· Press the “Space” bar or select the Speaker button with the mouse to terminate the call.

In addition to the basic calling operation, the user can also place calls by selecting records from the Phone Book folder, section 3.5.2, or Call Log folder, section 3.5.3.

The IPECS SoftPhone application must be the active application in order to place a call.

3.2.2 Receiving a Call

When a call is received, the phone will ‘ring’ and the Caller Information window will appear below the SoftPhone window, Figure 3.2.2.  The window shows the caller id delivered from the IPECS system and the name associated from the Phone Book database.  By selecting More from the window, the complete Phone Book record will be displayed.  If a call is received while the SoftPhone is minimized, the SoftPhone and Caller Information window will pop-up to display the incoming call.
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Figure 3.2.2 Caller Information window

To answer the call;

· Press the “Space” bar or select the Speaker button with the mouse.

· Press the “Space” bar or select the Speaker button with the mouse to terminate the call.

The IPECS SoftPhone application must be either the active application or minimized to the tray in order to receive a call.

3.3 Using IPECS System Features

The IPECS SoftPhone has complete access to all of the system features as well as the features available to the traditional IPECS phones, with the few exceptions based on the differences in the user platform, refer to section 5.5.  The fixed feature keys operate in the same manner as the IPECS phones except the mouse is used to select dial pad and feature buttons.  For operation of the features, refer to the IPECS Quick Guide or the IPECS Phone User Guide.

3.4 Appointment Calendar

IPECS SoftPhone Calendar window displays a monthly calendar and a scrolling appointment display below the calendar of daily appointments derived from the user’s Outlook scheduler.  By right clicking the mouse over a date on the calendar, an Appointment Summary window is displayed over the Calendar window, Figure 3.4a.
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Figure 3.4a Appointment Summary in Calendar window
The IPECS SoftPhone Calendar window permits on screen access to Outlook scheduler in two ways;

· double click on a date in the Calendar or

· double click on an appointment in the Summary window clicking the mouse right button.

 IPECS SoftPhone will call the Outlook scheduler so that the user can add or modify an appointment in the Scheduler edit box, Figure 3.4b.
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Figure 3.4b Outlook Scheduler edit window

· enter a new or edit an existing appointment following Outlook instructions.  When complete save and close the scheduler, this will save the file in the Outlook database and automatically update the IPECS SoftPhone Calendar database.

When browsing the Calendar, the user may return to the current date display by clicking the Today button next to the month/year display in the Calendar window, Figure 3.4c.
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Figure 3.4c Today button in Calendar window

3.5 Keyset Folder Operation

The Keyset view adds the 4 Keyset folders including the Flex Btn (Flexible or Flex Button), Phone Book, Call Log and Schedule Dial folders to the right side of the Phone view, Figure 3.5.  The separate folders are accessed by selecting the folder tab at the top of the Keyset folder window.
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Figure 3.5 Keyset view

A Phone Book database can be opened from the File menu, section 5.1.  Once accessed from the File menu, operation in the folder is the same as described in the following sections. 
3.5.1 Flex Btn Folder
The Flex Btn folder will display a 4 by 6 array of ‘Flex buttons’, total of 24, Figure 3.5.1.  Each button includes a status icon, which displays the status of the CO Line or station associated with the button.  The button also displays a designation from the IPECS system database, such as CO 001, SPD 001, etc.  A further label, which will be displayed in the button, can be assigned by the SoftPhone user under the Program menu, section 5.2.2.
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Figure 3.5.1 Flex Btn Folder

Selecting a Flex button with the mouse will access a CO line, call a station, or activate a feature based on the function assigned to the Flex Button in the IPECS system database.   

3.5.2 Phone Book Folder
IPECS SoftPhone maintains a Phone Book database, Figure 3.5.2a, of the users’ contacts, both other IPECS users and external contacts.  The user can place calls and send e-mails to contacts selected from the database employing the search, sort and record management tools in the Phone Book Tool bar.   When a record is added, edited or deleted in the Phone Book, the SoftPhone can also update the original source database, refer to section 5.1.1.
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Figure 3.5.2a Phone Book Folder with Call window

To call a number from the Phone Book;

· right click on the desired record, see search & sort below, and

· click the icon from the Call window: Dial, Transfer, Conference, Scheduled Dial.

or

· select the desired record and,

· click the Dial icon from the Phone Book Tool bar.

or

· double click on the desired record or phone number field.

To send an e-mail from the database;

· select the desired record(s),

· select the e-Mail icon from the Phone Book Tool bar, the Outlook e-mail program is called and loaded with the selected recipients,

· type in subject, message, etc. and send the e-mail.

To search the Phone Book database;

· key in alphanumeric string in the search box.

To sort records in the Phone Book;

· Click on the header field at the top of the Phone Book to sort alphabetically/numerically, click again for reverse order.

To add or edit a record;

· select desired record for edit,

· click the add or edit icon to view the Contact Record form, Figure 3.5.2b,

· key entries for available fields.  Fields include:

· * Name, required field

· Multiple Phone Numbers 

· E-mail address

· Company information

· Address

· Note 

· Image, to remove an image from the contact record, right click on the image to view the Clear Image pop-up dialog box.  Select Clear Image and OK.

· Select OK to save the record in the Phone Book and synchronize the source database.
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Figure 3.5.2b Contact Record Form

To delete a record;

· select the desired record(s),

· click the delete icon on the Phone Book Tool bar, the Confirmation window, Figure 3.5.2c will appear,

· confirm delete to remove the record(s).
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Figure 3.5.2c Delete Confirmation window

3.5.3 Call Log Folder
The Call Log folder, Figure 3.5.3, provides a log of all calls placed or received by the IPECS SoftPhone.  If Call Log is enabled under the File menu, each call initiated or received will generate a record which will contain information on the call as well as data derived from the Phone Book.  Once the call is completed, a record is stored in the Call Log database.  The record will contain the following fields:

· Date & Time: date and time of the call from the user’s PC

· Name: name of connected party from the Phone Book
· Phone: the called or calling party phone number, the later IPECS or carrier

· Call Type: type of call, incoming/outgoing and answer/no answer

· Duration: duration the call was connected in hours, minutes and seconds

· Note: note entered by user

· Company: from the Phone Book
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Figure 3.5.3 Call Log Folder

The Tool bar at the top of the logs, allows the user to place a call and manage the Call Log database.  To place a call from the Call Log;

· Double click on the record to place the call 

or

· select a record,

· click the Dial icon, IPECS SoftPhone will place a call to the phone number of record. 

To store the Call Log;
· click the Save icon.  The familiar Save As dialog box will appear, select a folder, if other IPECS SoftPhone,

· enter the filename

· select Save.  The file is saved in an *.xls format for easy future access and all records in the Call Log folder are deleted.

To add / edit a note or name field to a record;

· click the Edit icon,

· type the note or name in the edit dialog box,
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· Select OK to save in the Call Log.  Although all the fields of the call record are shown in the Edit dialog box only the Note and Name field can be edited and the Note field supports  up to 250 characters.

To add to the Phone book, Scheduled Dial;

· right click on the desired record

· click the Add to the Phone book, Scheduled Dial.

Selecting the Delete icon will remove the selected record(s) and selecting the Del All icon will delete all records in the Call Log.  In both cases, the user is asked to confirm the record deletion.

3.5.4 Scheduled Dial Folder
Scheduled Dialing permits the user to enter a phone number for dialing at a later scheduled time.  When the scheduled time is reached, the Dial Confirmation window, Figure 3.5.4a, will appear and must be confirmed by the user before dialing will begin.

[image: image17.png]Confirm Scheduled Dial!

Number (408) 443-6022
Name Dale Rice

Seat | [ X Cancel





Figure 3.5.4a Dial Confirmation window

The Scheduled Dial folder, Figure 3.5.4b contains a list of the phone numbers and schedules entered by the user.  The folder Tool bar permits the user to manage the Scheduled dialing feature. 
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Figure 3.5.4b Schedule Dial folder

To add or edit a Schedule Dial;

· click the Add or Edit button on the Schedule Dial Tool bar icon and the Schedule Dial dialog box, Figure 3.5.4c appears,

· click the calendar to input the date, date is a required entry,

· select the time (in 24 hour mode) from drop down selection menu, time is a required entry,

· input or edit the telephone number, the telephone number is a required entry,

· input or edit name,

· select OK to save the schedule and number for later dialing.  A date, time and number must be entered.  
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Figure 3.5.4c Schedule Dial dialog box

To delete an entry from the Scheduled Dial folder;
· select Delete to remove the record.  The user will be asked to confirm the record deletion.

3.6 SMS (Short Message Service)

SMS (Short Message Service), which is typically provided in GSM mobile networks, is a service permitting users to share (send and receive) text messages with other users.  A text message is comprised of an alphanumeric combination of up to 100 characters.  When an SMS message is received, the Message Wait indication will activate and the user’s IPECS SoftPhone or display phone, can review the received message.  The IPECS SoftPhone can maintain up to ten received messages after which, new messages are not stored.
To send a text message to other users;

· enter the message in the SMS window, Figure 3.6a,

· select Send To in the SMS window, the Recipient window, Figure 3.6b, appears,

· select the desired recipients with the check boxes or range (From & To) boxes,

· select Send, the message is delivered.
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Figure 3.6a SMS window
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Figure 3.6b SMS Recipient window

To review received SMS messages, the LED of the fixed feature button MSG/CB will flash;

· select the flashing MSG/CB button, the SMS Receive window with a radio button for each SMS message will appear, Figure 3.6c,

· select the desired radio button,

· select Delete to remove the message.
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Figure 3.6c SMS Receive window

4 IPECS SoftPhone Tool Bar Operation

4.1 SoftPhone View

IPECS SoftPhone provides the user with a visual representation of a Phone on the desk-top.  There are two views for the SoftPhone, Phone and Keyset.  The Phone view emulates the appearance of the traditional IPECS phone displaying an LCD area, keypad and fixed feature buttons.  The Keyset view adds the Keyset folders window.  This window has 4 tabbed folders the user can view; the Flex Btn folder with an array of 24 buttons, the Phone Book folder to show the user’s Phone book, the Call Log folder displays records for each call placed or received by the SoftPhone, and the Scheduled Dial folder, which permits the user to assign a phone number for dialing at a scheduled time.
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The view is controlled by the Phone/Keyset icon at the far left of the SoftPhone Tool bar, Figure 4.1.  When selected, the SoftPhone view will toggle between the Phone and Keyset views.
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Figure 4.1 Phone/Keyset Tool bar icon

4.2 e-Mail Operation

With the IPECS SoftPhone, the user can access the Outlook e-mail application to send ad hoc e-mails.  Access to the e-mail application is controlled by the e-Mail icon on the SoftPhone Tool bar, Figure 4.2.
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Figure 4.2 Tool bar Mail icon

IPECS SoftPhone will call the Outlook e-mail application when the e-Mail icon is selected.  The e-mail application can also be called from the e-Mail item in the Program menu, section 5.2.1.

4.3 Record Operation

IPECS SoftPhone allows the user to record an active conversation to the PC’s hard disk.  Recording is controlled using the Record icon on the SoftPhone Tool bar, Figure 4.3.

· Select the Record icon to start recording,

· select the icon again to stop recording,

· when the recording is complete, SoftPhone will ask the user for a filename to use for storing the recording.
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Figure 4.3 Tool bar Voice Record icon
IPECS SoftPhone generates a single record-start tone, you should notify other parties to any recording.  Playback and management of recorded voice files is accomplished under the Tools menu Voice Record item, section 5.3.1.

4.4 Exit 

[image: image42.wmf]The user may terminate the IPECS SoftPhone application using the Exit icon on the Tool bar, Figure 4.4.

Figure 4.4 Tool bar Exit icon

5 Menu Bar Operation

5.1 File Menu
The File menu gives access to the Phone Book and Call Log database management functions.

5.1.1 Phone Book

Selecting Phone Book from the File menu will present the Phone Book menu where the user may manage the Phone Book database, Figure 5.1.1.  From this menu, the user may select to open a new or existing database, save a database, import or export a database or maintain synchronization with an external database.  Once a Phone Book is opened, operation of the folder is the same as with the Keyset view, see section 3.5.2.
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Figure 5.1.1 Phone Book Menu

The user may open a new blank database for use with the Phone Book folder;

· select New from the menu,

· select a folder location,

· enter a filename.

The user may select the database to employ for the Phone Book folder.  Once selected, the selected database name will appear on the Phone Book tab and the database is used for IPECS SoftPhone Phone Book until a new selection is made by the user.  To open a selected database;

· select Open from the menu,

· select a database.  The file format of the database must be consistent with the *.DB file format of the IPECS SoftPhone database; other file type selections will receive a warning message.

Various contact manager applications employ different data formats.  To permit use of common formats, IPECS SoftPhone allows the user to import databases from Outlook, GoldMine, ACT! or Excel applications.   When imported, the database format is modified to match the Phone Book database and displayed in the Phone Book folder.  To import a database;

· select Import from the Phone Book menu,

· select the application type, Outlook, Gold Mine, ACT! or Excel,

· select the database.

The user may save a copy of the Phone Book database as a back-up copy or for future use.  To save a copy of a database;

· select Save As… from the Phone Book menu,

· select a folder, if different than the IPECS SoftPhone folder,

· select the filename,

· select Save.

The Phone Book database can be exported for use in other applications including Outlook, Gold Mine, ACT! or Excel.  To export a Phone Book database;

· select Export from the Phone Book menu,

· select the application type , Outlook, Gold Mine, ACT! or Excel,

· select the database.

The Phone Book can be synchronized with an external Outlook, Gold Mine or ACT! database automatically.  When synchronized, each time the IPECS SoftPhone is started it will use the external database as the Phone Book and will update the external database after any changes in the Phone Book.  To enable automatic synchronization,

· select Sync DB from the Phone Book menu,

· select the application type, Outlook, Gold Mine, ACT! or Excel,
· select the database.

Note that changes made directly to an external database are not effective in an active IPECS SoftPhone.  Such changes require a restart of the IPECS SoftPhone application to update the active Phone Book database.

5.1.2 Call Log 

Selecting Call Log from the File menu will display the Call Log menu, Figure 5.1.2.  From the Call Log menu, the user may enable or disable the Call Log function.
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Figure 5.1.2 Call Log menu

5.2 Program Menu

5.2.1 e-Mail

With the IPECS SoftPhone, the user can access the Outlook e-mail application to send ad hoc e-mails.  Access to the e-mail application is provided by the e-Mail item in the Program menu, which, when select, will call the Outlook e-mail application.  The e-mail application can also be called from the e-Mail icon on the IPECS SoftPhone Tool bar, section 4.2 or from the Phone Book.

5.2.2 Flex Data 

In the Flex Btn folder, each button is displayed with a status icon and a designation provided to the SoftPhone by the IPECS system, refer to section 3.5.1.  For convenience, the user can enter a label that will be shown in the lower portion of the button.  To assign Flex button labels;

· select the Flex Data item from the Program menu, the Flex Data window, Figure 5.2.2a, will appear,
[image: image27.png]FLEX1

FLEX2

FLEXS

FLEXS

FLEXS

FLEXG

FLEXT

FLEXS

FLEXS

FLEX10

FLEX 11

FLEX12

Lapout

et





Figure 5.2.2a Flex Data Window

· select the desired Flex button (FLEX 1 to FLEX 24) label field,

· type in the desired label, up to 12 characters,
· if you check the Left/Right of the Layout box, the new labels are aligned to the left/right side of the flex button. 

· click OK,

· when complete, click on the Close icon to return to the IPECS SoftPhone screen, the new labels will be shown in the Flex Btn folder, 5.2.2b.
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Figure 5.2.2b IPECS SoftPhone screen with Flex Data labels
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5.2.3 Dialing Rules

When the user places an outside call from the Phone Book or Call Log folder, the IPECS SoftPhone must include certain dial codes to assure proper dialing through the IPECS system.  When a number is selected from either database, the system will determine the type of call and insert any CO Access Code, LD Access Code or International Access Code required for the host IPECS to properly establish the call.  Codes are entered in the Dialing Rules dialog box, Figure 5.2.3, along with local codes for comparison.  To enter codes;

· select Dialing Rules from the Program menu,

· enter the various codes,

· select OK.
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Figure 5.2.3 Dialing Rules dialog box

5.2.4 Differential Ring

The IPECS SoftPhone can provide one of 4 different ring signals with separate assignments for internal and external calls.  Each of the 4 ring signals is contained in a *.wav file.  The user may select one of the 4 predefined *.wav files (ring1.wav, ring2.wav, ring3.wav and ring4.wav) or may replace any of these files with a desired *.wav or *.mp3 file.

Selecting Program > Differential Ring displays the Ring tone files window, Figure 5.2.4.  To change a Ring tone file,

· select the change icon next to file to be replaced,

· select the desired *.wav or *.mp3 file from the PC’s file system, and

· select Change,

· close the Ring tone files window and the new file may be selected for use.
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Figure 5.2.4 Ring tone files window

To select a Ring Tone for use;
· click the PGM fixed feature button,

· dial 1 for Ring Tone Selection,

· dial 1 for Intercom Ring or 2 for CO/IP ring,

· dial desired Ring Tone (1-4), a short burst of the tone is generated,

· press SAVE.

5.3 Tools Menu

5.3.1 Voice Record

IPECS SoftPhone permits recording of a conversation onto the PC’s hard drive.  Recorded conversations can be reviewed after recording.  In addition, a voice memo can be added to the recording and the recording with memo sent by e-mail as attached *.wav files.

Selecting Tools > Voice Record displays the Record/Play selection menu.  Selecting Record while in a conversation will activate the recording function; recording both sides of the IPECS SoftPhone conversation.  Recording may also be activated from the SoftPhone Tool bar, refer to section 4.3.  IPECS SoftPhone sends a single record-start tone; you should notify the other parties to any recording.

Selecting Play will show a list of recorded files in the Playback window, Figure 5.3.1.  The window includes playback controls for playing a selected file.  The user may delete a file, record a comment, and/or e-mail the recording using the Playback window controls.
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Figure 5.3.1 Recorded Files & Playback Window & Controls

5.3.2 Connection Mode

IPECS SoftPhone can be registered to an IPECS system in Local or Remote Mode.  In the Remote Mode, IPECS allocates a VoIP channel to support the call.  The VoIP channel implements NAT (Network Address Translation) compatibility and packet forwarding to internal appliances.

Selecting Tools then Connection Mode, will display the Local/Remote selection window with the present mode checked.   When either mode is selected, which is done with the mouse, the IPECS SoftPhone will terminate and re-connect with the host IPECS system to establish the selected connection mode.

5.3.3 Date Format

The format used for the date display of the Phone Book, Call log and Scheduled Dial folders can be changed from day/month/year to month/day/year.  Selecting Tools then Date Format will display the format selection window with the present selection checked.   Click the desired Date Format in the menu.

The date display for the IPECS SoftPhone LCD area is controlled by the IPECS system and may be different from the selected Date Format. 

5.3.4 Language  

The IPECS SoftPhone supports two languages, English and Local Language.  The Local Language is translated from English and edited into the ‘language.txt’ file located in the IPECS SoftPhone directory.  For additional help, access the ‘language.txt’ text file in the IPECS SoftPhone folder.

Selecting Tools then Language, will display the English/Local Language selection window with the present mode checked.   After selecting the desired language you must restart the IPECS SoftPhone application.  Also, if any changes are made to the language.txt file, restart IPECS SoftPhone to load the changes in the SoftPhone’s active memory.
5.3.5 Minimize

When the IPECS SoftPhone application is executed, a tray icon is created, Figure 5.3.5a.  When the application is “minimized”, the IPECS SoftPhone icon is moved to the desk-top tray.  In this way, the application does not clog the program tray.
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Figure 5.3.5a IPECS SoftPhone Desk-top Tray icon

To restore the IPECS SoftPhone;

· click the tray icon 

or 

· ‘right-click’ with the mouse pointer on the icon and 

· select Show or Exit from the pop-up menu.
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Figure 5.3.5b IPECS SoftPhone Desk-top Tray Menu

5.4 Help Menu

5.4.1 Help

The IPECS SoftPhone Help yields a wealth of information on the operation of the SoftPhone specific features as well as standard IPECS station features available to the SoftPhone.  To access the Help menu, select the Help item from the menu or press the “F1” key.

The IPECS SoftPhone Help window, Figure 5.4.1, appears showing major topics covered for the IPECS SoftPhone.  Additional topics are available under the Help Topics menu and covers operation of standard IPECS user features.
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Figure 5.4.1 Help Window

5.4.2 About

The About item from the Help menu displays the version, IP address, MAC address, and connection mode for the IPECS SoftPhone, Figure 5.4.2.
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Figure 5.4.2 Help Menu About screen

5.5 IPECS SoftPhone User Programming

As previously noted, the IPECS SoftPhone operates in the same manner as the traditional IPECS phone.  There are however several user programmable functions which are not supported due to differences in the platform, i.e. PC versus IPECS phone.  The user programmable functions not supported by the SoftPhone include:

Station Answer mode, IPECS SoftPhone does not support Intercom Call Announce and, thus supports only Privacy for the Station Answer mode.

Station Ring Download, IPECS SoftPhone can not download ring tone files from the IPECS system, the SoftPhone user can change the ring tone files stored in the IPECS SoftPhone folder, see section 5.2.4.

Audio source control, IPECS SoftPhone has a single audio path and thus can not support the dual path (headset and speaker) controls available with the traditional IPECS phone.
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